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2.0 Introduction 
 
Welcome to layered documents with Adobe ® Acrobat ® and ARTS PDF Stratify™ from 
ARTS PDF™ 
 
ARTS PDF Stratify extends the usability of PDF documents by allowing for the creation 
and management of layers for such uses as versioning, multi-lingual publications, and 
multipurposing, to name but a few. 
 
With Acrobat versions to date, there is no concept of layers. This effectively restricts 
document creators to making multiple different versions of a PDF for each need, or 
staying with a page layout application which supports layers. 
 
ARTS PDF Stratify allows document creators flexibility in how they create and manage 
layers in PDF documents. For existing documents ARTS PDF Stratify provides an easy 
to use method for creating layers, selecting objects and adding them to layers. For new 
documents it provides an approach that allows multi-page documents to be converted to 
PDF, then “flattened” to as small as a single page with all of the document content on 
layers. 
 
ARTS PDF believes that the use of layers in creator applications is widespread, and that 
users have long desired the ability to employ a similar level of functionality in Adobe 
Acrobat. Combining the benefits of the PDF format and ARTS PDF Stratify’s layer 
creation capabilities means that usage of PDF can be extended to encompass a wider 
range of applications and simplify document management. 

 

 This document contains information on both the Macintosh and Windows version of ARTS 

PDF Stratify. Wherever appropriate, the differences are clearly indicated. 
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3.0 ARTS PDF Stratify Setup 
 
ARTS PDF Stratify adds another dimension to Adobe Acrobat and PDF pages – layers. 
ARTS PDF Stratify lets you control the creation and management of layers and their 
content. ARTS PDF Stratify is great for creating and maintaining different versions of the 
same document, multi-lingual work, localized price and product changes, ad insertion 
instructions, and other alternate content.  
Create & name layers in PDF pages 
 

• Show & hide layers 
• Add objects to layer(s) 
• Remove objects from layer(s) 
• Merge, delete or rename layers 
• Convert pages to layers 
• Add a page as a layer 
• Move objects forward, send back 
• Lock layers 
• Print exposed layers only 
• Save – saves all layers, displays exposed layers 
• Works with any Acrobat PDF page 

 

3.1 System Requirements 
 

3.1.1 Macintosh 
 
• PowerMacintosh G3 or G4  
• System 9.2 or 10.2 or higher  
• Adobe ® Acrobat ® 5.05 or higher  

 

3.1.2 Windows 
 
• PC with Pentium processor 
• Windows ® NT 4.0, Windows ® 2000 or Windows ® XP  
• Adobe ® Acrobat ® 5.05 or higher 
 


 CAUTION: Any folders or files which are created during installation are required by 
Crackerjack. If you rename, move, or delete these folders the product will not work correctly 
or may not work at all. 
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3.2 Installation 
 

In addition to the User’s Guide, the ARTS PDF Stratify folder contains other support files 
needed by ARTS PDF Stratify.  
 
To validate the software’s registration and/or to view the installation status, open Acrobat 
and view the “About Plug-Ins” box at the bottom of the Acrobat Help pulldown menu for 
“ARTS PDF Stratify...”. The word “***Unregistered***” appears in the ARTS PDF Stratify 
“About” box when the version is not fully licensed. To validate your license, click on the 
“Register...” button, and then enter the serial number provided by ARTS PDF.  
 
To deactivate the plug-in, move it and the ARTS PDF Stratify folder out of the Acrobat 
Plug-Ins folder before launching Acrobat. 
 

3.3 Demo Mode 
 
When ARTS PDF Stratify is in demo mode it will notify the user that changes to the 
document cannot be saved. Otherwise, the demo version of ARTS PDF Stratify is 
identical to the licensed version. 
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4.0 Using ARTS PDF Stratify  
 

4.1 Launching ARTS PDF Stratify 
 

To use the software launch ARTS PDF Stratify using the  button on the Acrobat 
toolbar. ARTS PDF Stratify will then display its layers dialog box. 
 

4.2 Usage Notes 
 
Often designers create documents in layout applications, such as Quark Express, Adobe 
InDesign, or Adobe PageMaker, which include layered information.  But how does one 
transfer this layered knowledge to a PDF document?  The problem is that there is 
currently no support for layers in the PostScript files that Adobe Acrobat Distiller uses to 
create the PDF documents. 

 
There are two basic ways to create layers using ARTS PDF Stratify. These are: 1.) In 
the layout application, output complete pages and use these when creating the PDF 
document. The PDF will have pages containing all the required objects. Then use ARTS 
PDF Stratify’s “Layers” and “Elements” options to create layers and add objects to them, 
and 2.) Alternatively, from the layout application, you can output layers individually, 
distill, and combine into a single PDF document. Then, use ARTS PDF Stratify’s 
“Convert pages to layers…” option to make a new page with layers. 

 
It is recommended that significant amounts of new information can be added first to the 
document as a new PDF page, and then as a layer to a page using ARTS PDF Stratify’s 
“Add page as layer…” function. For example, this might be appropriate when localized 
versions of new prices and alternate products are finalized, or when adding newspaper 
or magazine insertion instructions for ads based on layered PDF pages. 

 
ARTS PDF Stratify will display all layers that are not hidden. When you save the PDF 
document, all the layer information and elements are included in the document. When 
you reopen the document, all of the non-hidden layers will display. When you print, all of 
the non-hidden layers will print. When you search the document, items on hidden layers 
may be found, but you will not see them.  ARTS PDF Stratify must be used in order to 
access the layer information and manage which layers will be visible. 
 

4.3 Preferences 
 
The preferences for ARTS PDF Stratify can be set using the standard Acrobat method of 
File -> Preferences -> ARTS PDF Stratify. After making changes in this window click 
“OK” to make them permanent. Clicking “Cancel” will return the preferences to the last 
values stored. 
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4.3.1 Remember window positions 
 
When this option is checked the 
position of the ARTS PDF Stratify 
layer management window will be 
saved when you quit Acrobat. It will 
then open in the same position the 
next time Acrobat is launched. 
 

4.3.2 Allow partial select 
 
This determines whether objects will 
be selected when only a part of the 
image is touched by the ARTS PDF 
Stratify object select tool. If this is off 
(unchecked) the entire object must fall within the selection rectangle in order to be 
selected. 
 

4.3.3 Select text runs 
 
Acrobat returns all text in a stream that appears consecutively as a single text object. 
Each of these objects is divided up into things called text runs. “Select text runs” here 
means that when you select text objects you are actually selecting the text runs, instead 
of the whole object. This allows the user to assign the text runs of the text object to 
different layers. If this is not checked then the text object will be basically considered a 
single text object.  
 

4.3.4 Group text in batch mode 
 
Essentially “batch mode” for selecting text runs. When the “Convert pages to layers” is 
chosen from the ARTS PDF Stratify menu on the Acrobat toolbar this function 
determines whether text runs will be converted as a single text object or broken up into 
text runs. Unless there is a need to maintain the ability to select text as objects, it is very 
much desirable to do it this way.  
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4.4 The ARTS PDF Stratify Window 
 
This window allows the user to create and manage layers with the current Acrobat 
document. On the Macintosh version the window may be resized vertically by clicking 
and holding with the mouse in the area between the layer list and the bottom of the 
window. 
 

4.4.1 Layers 
 
• New... 
 
Clicking this button causes a new layer to be created. 
A dialogue box will appear with a fill-in field for the 
layer name. 
 
• Delete 
 
When an existing layer is selected, this button allows 
the user to delete the layer. When layers are deleted 
the objects within the layer remain in the document. 
 
• Merge... 
 
The user can select two or more layers then click this 
button to merge them into a single layer. 
 
• Security... 
 
This button is used to set a password for the 
document. The password is used to control the 
locking and unlocking of layers. 
 


 Note: Setting security for layers does not affect overall 
document security. Document editing tools such as the 
Acrobat touch up tools or ARTS PDF ImageWorks can 
still be used to make changes to objects in the 
document. For complete document security use 
Acrobat’s security features. 

 
• Rename... 
 
After selecting a layer this button allows the user to change the layer’s name.  
 
• Select 
 
This button will cause all of the objects in currently highlighted layer(s) to be selected. 
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4.4.2 Elements 
 
• Add 
 
After selecting objects on the page clicking this button will add those objects to the 
currently selected layer(s). 
 
• Remove 
 
After selecting objects on the page clicking this button will remove those objects from the 
currently selected layer(s). 
 
• Show/Hide 
 
When a layer is highlighted in the list window clicking this button will cause the currently 
selected layer(s) to either be displayed or removed from the Acrobat viewer. The button 
label will toggle between “Show” and “Hide” depending on the current state of the 
selected layer. If multiple layers are selected and one or more of them are hidden, the 
button will default to “Show”. Individual layers can also be shown or hidden by checking 
the box next to the layer name. 
 
• Lock/Unlock 
 
When a layer is highlighted in the list clicking this button will cause the currently selected 
layer(s) to be locked or unlocked. The button label will toggle between “Lock” and 
“Unlock” depending on the current state of the selected layer. If multiple layers are 
selected and one or more of them are locked, the button will default to “Unlock”. 
 

4.4.3 Selection 
 
As objects are selected the display will change to show the total number of objects 
currently selected. 
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4.5 Selecting Objects 
 
The ARTS PDF Stratify object selection tool  can be used to select objects to be 
added to a layer(s), removed from a layer(s), or manipulated using one of the 
forward/backward options from the ARTS PDF Stratify tools menu. 
 
There are several methods for selecting objects. When an object is selected a dotted 
line will appear around it. As objects are selected the number of objects currently 
selected will appear in the ARTS PDF Stratify window in the “Selection” section. 

 

 Objects may be added to more than one layer. If an object is assigned to more than one layer 

and any of those layers are set to “Show” in the ARTS PDF Stratify window then the object 
will be displayed in the Acrobat viewer. 

 

4.5.1 Selecting Single Objects 
 
Simply click on an object in the PDF document to select it. 
 

4.5.2 Selecting Multiple Objects 
 
Multiple objects can be selected in two ways. One is to click on a single object, then hold 
down the “Shift” key while clicking on additional objects. The second method is to use 
“drag select”. This is done by moving the object selection tool onto the PDF page then 
dragging it to create a rectangle around all objects the user wishes to select. 
 

4.5.3 Selecting “Stacked” Objects 
 
Occasionally smaller objects will appear “behind” larger objects making it difficult to 
select them. To select objects behind others hold down the “Command” key 
(Macintosh) or “Ctrl” key (Windows) while clicking on the desired object. If there are 
multiple smaller objects, holding down the “Command” / “Ctrl” key while clicking will 
cause the selection to cycle through all objects directly under the current cursor position. 
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4.6 ARTS PDF Str
 

atify Tools 

he “ARTS PDF 
 be 

 

his list of tools gives 

T
Stratify” tools can
accessed from the 
Acrobat toolbar under
Tools. 
 
T
the user various 
options for creating 
layers as well as 
managing the order in 

hich objects appear on layers. w
 

4.6.1 Convert pages to layers... 
 
This function is very useful for such things 
as converting multiple pages to a single 
page with multiple layers. In this case 
each layer would contain all of the objects 
which were on the page it came from. 
When this function is used a new page w
be created at the end of the current 
document and the layers will be added to 
this new page. The user can elect to 
convert all pages to layers, or a selected 
range of pages. 

ill 


  
 

 objects on the new layered page, 
followed by the objects from page 2 on top of them, etc. 

 

 
ARTS PDF Stratify supports non-contiguous and reverse order page ranges. For 
example: “pages 5-1” or “1-3,6-8,13”. 

 
Note: When pages are converted to layers the page layers will be “stacked” on the new page
in the order they were converted. In other words, if the user selects a page range of 1-5, the
objects from page 1 will be at the “bottom” of the stack of

4.6.2 Add page as layer... 
 
Similar to “Convert pages to layers...”, this 
function allows the user to add an entire page 

s a new layer on the current page. a
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4.6.3 Bring forward 
 
When an object(s) are selected using the ARTS PDF Stratify object select tool, selecting 

is function will cause the object(s) to move forward one level relative to other objects 
on the page. 
th

 

4.6.4 Send back 
 
When an object(s) are selected using the ARTS PDF Stratify object select tool, selecting 

is function will cause the object(s) to move backward one level relative to other objects 
on the page. 
th

 

4.6.5 Bring to front 
 
When an object(s) are selected using the ARTS PDF Stratify object select tool, selecting 

is function will cause the object(s) to move forward to the most forward level relative to 
other objects on the page. 
th

 

4.6.6 Send to back 
 
When an object(s) are selected using the ARTS PDF Stratify object select tool, selecting 

is function will cause the object(s) to move backward to the most backward level 
relative to other objects on the page. 
 

th
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5.0 Troubleshooting 
 
Before contacting us please check the ARTS PDF Stratify conference at the ARTS PDF 
Forum on our web site at: http://forum.artspdf.com
 
If you have no luck there, please e-mail techsupport@artspdf.com and supply the 
information below to help us replicate the problem you are experiencing. 
 

a. The platform (Mac or Windows) you are using. 
b. The exact version of ARTS PDF Stratify you are using (this is located by running 

ARTS PDF Stratify, and then clicking Help → About Third-Party Plug-Ins → 
ARTS PDF Stratify). Please also specify whether you are using a demo or full 
registered version. 

c. The exact version of Adobe Acrobat you are using (this is located by running 
Adobe Acrobat, and then clicking Help → About Acrobat). 

d. The exact version of the Operating System you are using. 
e. A description of the expected behavior versus the actual behavior 
f. The minimum PDF file that exhibits the behavior. 
g. If applicable, please include the resultant PostScript file or a description of the 

output configuration (RIP model, PostScript interpreter version number, and 
output device model) 

 
 
 
Feedback If you have ideas and suggestions on how we could improve ARTS 

PDF Stratify, we would love to hear your thoughts. Please send them 
to info@artspdf.com
 

Legal Notes  
 

“Adobe” and “Acrobat” are either registered trademarks or 
trademarks of Adobe Systems Incorporated in the United States 
and/or other countries. “Windows” is a registered trademark of 
Microsoft Corporation in the United States and other countries. 
ARTS PDF Stratify is Copyright © ARTS PDF 2003. 
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